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:HOFRPH�

Welcome to GroupSystems® Staff Meetings for Workgroups! 
Congratulations on joining the high-performance world of 
collaborative technology for work teams.

With Staff Meetings for Workgroups you and your team will streamline 
and improve productivity of those often-painful staff meetings.

Organizations have achieved substantial benefits using Staff Meetings 
for Workgroups for:

n Weekly staff status checks

n Information sharing

n Reduced conference call duration

n Knowledge management

n And more!

Note: You must have GroupSystems Workgroup Edition installed on your 
network to use Staff Meetings for Workgroups. In the remainder of this 
Guide, the term “Workgroup Edition” will include all versions 2.x of 
the software, and may be abbreviated as WGE. Staff Meetings for Work-
groups may be abbreviated as Staff Meetings (italicized).

Ventana Corporation Technical Support: (800) 325-8026
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6RIWZDUH�DQG�+DUGZDUH�5HTXLUHPHQWV

0LQLPXP�5HTXLUHPHQWV

GroupSystems Workgroup Edition

Network Operating Systems
Novell NetWare version 3.11, 3.12, 4.1, or Win-
dows NT Server 3.51, 4.0 (with Service Pack 3)

Client Operating Systems
Microsoft Windows version 3.1 or 3.11, or
Windows 95, or Windows NT Workstation 3.51 or 4.0

File Server 
A dedicated file server with 32 MB RAM 
and at least 40 MB free disk space

Workstation
486 processor, 16 MB RAM, color monitor, hard drive 

Local Area Network 
Ethernet (10 Mbps) or Token Ring (16 Mbps)

5HFRPPHQGHG�&RQILJXUDWLRQ

Network Operating Systems 
Windows NT Server 4.0 (with Service Pack 3)

Client Operating Systems
Windows 95 

File Server
Pentium-based, 64 MB Ram, 1 GB hard drive, 
32 bit Ethernet network card

Workstation
Pentium-based, 32 MB RAM, 30 MB free hard disk space reserved for 
GroupSystems executable files 

Local Area Network
100 Base-T Ethernet 
3DJH�� �������9HQWDQD�&RUSRUDWLRQ 6WDII�0HHWLQJV�IRU�:RUNJURXSV



8QGHUVWDQG�6WDII�0HHWLQJV�IRU�:RUNJURXSV

A successful staff meeting is a regularly scheduled, timely sharing of 
information and decision-making, where everybody contributes, and 
complete records are made available in a timely fashion.

Since staff meetings usually involve status reports and information 
sharing (communication which could occur prior to a face-to-face meet-
ing), teams are more effective when this basic information exchange 
occurs in a structured process and activity prior to the actual face-to-
face event. 

Staff Meetings for Workgroups provides you and your team with a pro-
cess and structure with which to improve communications, capture all 
of the necessary information in a legible and timely fashion, and 
streamline the synchronous face-to-face activity so we can “get back to 
our day jobs”. The net result is time savings (and therefore, money), 
complete records, and fewer headaches.

Conducting staff meetings using GroupSystems will save your team the 
time and expense associated with traditional face-to-face staff meetings. 
The electronic format allows team members to contribute status infor-
mation and ask questions of one another at any time that is convenient 
for them. The staff meeting is accessible at all times, and is unaffected 
by differences in schedules, time zones, etc.

When the team wants to meet face-to-face, the information from the 
GroupSystems staff meeting can easily be used as a reference point, mak-
ing face-to-face work more productive.

3URFHVV�

With Staff Meetings for Workgroups, your team will use a structured 
format to work through four steps:

1. Contribute in advance. Prior to the face-to-face event, the team 
leader sends an electronic invitation to the meeting participants. 

If your face-to-face meetings are JUST PERFECT RIGHT 
NOW, then consider using this Staff Meeting template for 
only the face-to-face portion of the process (along with a 
designated “scribe” to capture verbal contributions during 
the meeting).

5HPHPEHU�7KLV���
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Upon acceptance of the invitation, each team member joins that 
week’s activity. Members submit status information, requests for 
information, requests for decisions, and share data, information, 
and opinions from their desktops. Members must participate in this 
distributed event prior to the synchronous meeting. This 
asynchronous preparation is the key to successful Staff Meetings for 
Workgroups.

2. Meet synchronously. The team meets face-to-face. The team 
members respond to requests for information, requests for 
decisions, and capture last-minute updates. A team “scribe” can 
capture this last-minute verbal information in the activity.

3. Follow through. After the face-to-face meeting, members can refer 
back to the meeting at any time. A report can be created and 
distributed easily to other departments and management.

4. Repeat. Repeat this process for each regularly scheduled meeting. 
Consider using this format prior to ad-hoc meetings as well.

The following steps will be covered:

1. Create a folder in GroupSystems for the staff meeting. 

2. Create a master copy of the electronic staff meeting in the format 
you prefer. You will copy this master to create subsequent staff 
meeting activities.

3. Invite the team members who should participate in the staff 
meeting. This can easily be done via your company’s e-mail package 
by sending a link to the GroupSystems staff meeting.

4. Contribute status information to the staff meeting, then edit and 
organize that information.

5. Create, view and distribute electronic or paper reports to maintain 
an accurate and detailed record of the staff meeting activity.

This guidebook lays out the steps with sufficient detail that beginning 
users can navigate the process smoothly and efficiently. Team leaders 
and team members who have basic familiarity with the tools and use of 
GroupSystems will have an even shorter learning curve. 
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:KDW�LV�*URXS6\VWHPV"

GroupSystems Workgroup Edition (WGE) is a suite of tools to structure 
and enhance team effort. WGE can vastly improve your organization’s 
planning, decision-making and idea-gathering processes, and increase 
productivity. It is based on more than 10 years of real-world group 
decision software use. 

GroupSystems Workgroup Edition supports group processes such as:

n List building and information gathering

n Brainstorming, problem solving and decision making

n Organizing, prioritizing and voting

n Project planning and tracking

n Knowledge management, process improvement and business 
planning

The tools are used interactively by people working at separate comput-
ers or face-to-face.

+RZ�3HRSOH�&RQQHFW�8VLQJ�*URXS6\VWHPV

WGE lets all members of your team exchange ideas anonymously and 
simultaneously—regardless of their location in the world—via local 
area network (LAN) or the Internet.

You can also run WGE over the Internet, via a browser. Contact Ventana 
Corporation for information on how to do this. 

If you have a question about how to use GroupSystems 
while you are participating in an activity, click the Help 
button. You will see instructions that are specific to the 
window you are in.

5HPHPEHU�7KLV���
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�,

*HWWLQJ�6WDUWHG

6WHSV

q Before You Begin

q Plan the Staff Meeting Format

q Launch the Staff Meeting

6WDII�0HHWLQJV
IRU�:RUNJURXSV
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%HIRUH�<RX�%HJLQ

Before you begin using Staff Meetings for Workgroups with your team….

Check the system: 
(Get help from your GroupSystems administrator if need be.)

1. Ensure that all team members’ computers have an icon pointing to 
the same installation of GroupSystems, using the same drive 
mapping on the LAN (for example, V:/Ventana/Gswin/).

2. Ensure that all team members have GroupSystems login names and 
passwords in the GroupSystems Organizational Roster. It is possible 
to include the login name and password on the command line of the 
GroupSystems icon. You must decide whether your facility provides 
adequate security for this approach.

3. Learn how to log into GroupSystems if you don’t already know. Ask 
your GroupSystems administrator for a lesson if you need one.

Do your homework:

1. Read the Staff Meetings for Workgroups guidebook from start to finish 
to be sure you understand the process. You may write notes to 
yourself in the wide margins provided in this guidebook.

2. Try out each technical instruction to be sure you understand how to 
use the software.

3. Practice the process on a small group before introducing it to the 
whole group.
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3ODQ�WKH�6WDII�0HHWLQJ�)RUPDW

It will be helpful for the team leader to consider his or her department’s 
specific needs before launching the GroupSystems staff meeting.

n Does your staff need frequent face-to-face contact, or not as much? 

n Do you have team members at several geographic locations, or who 
work rotating schedules? 

n Does your staff travel frequently? 

Each of these considerations will affect how you plan the GroupSystems 
staff meeting process.

When introducing the process to your team, it may be a good idea to 
start with a weekly electronic staff meeting that is followed by a now 
shorter, less frequent and more efficient face-to-face meeting. 

Once the group has become accustomed to the electronic format, you 
may find that it is less important to meet every week because much of 
the relevant information has been captured in the GroupSystems staff 
meeting.
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Why do you wish to do this? Perhaps your current staff meetings last 
over an hour, or are an unproductive waste of time. Perhaps meetings 
are frequently cancelled or rescheduled due to schedule conflicts. 

Experience shows that staff meetings do not require all participants to 
be “present” as long as their information is captured and otherwise 
available to other team members.

n Determine your goals.

n Get buy in from your team (why we are doing this—what are your 
thoughts about our current staff meetings?).

n Remind them what they are missing—they may love not having to 
spend hours of their day talking about who should change the toner 
in the copier! 

n Tell them how it will be done.

n Lay out your requirements and expectations of them.

n Remind them that the face-to-face portion is not going away; it’s just 
more streamlined and productive this way.

n Be sure deadlines and deliverables are explicitly defined.
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&KDOOHQJHV�RI�$V\QFURQRXV�:RUN

Keep in mind that successful asynchronous work is 
challenging and very different than face-to-face work. A 
major issue for asynchronous teamwork involves 
interruptions. These interruptions often involve the 
telephone, fax, email, and people "stopping by your desk". 
All of these things are likely to seem more urgent than 
contributing to the Staff Meeting outline. As Stephen R. 
Covey discusses in his book, The Seven Habits of Highly 
Effective People, we often devote time to tasks that are 
urgent, such as ringing telephone, even though a more 
important but not as urgent task awaits us.

Motivating teams thus becomes a crucial leadership task. 
Make sure responsibility is clearly delegated at the outset 
of the asynchronous teamwork.

5HPHPEHU�7KLV���
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0DLQWDLQLQJ�WKH�*DLQV

You should experience streamlined staff meetings after 
implementing the Staff Meeting. You should also 
experience increased information sharing, better 
organizational memory, and easier knowledge 
management. To help maintain these gains, keep in mind 
the following:

n Help the solutions succeed—work as a team to identify 
any barriers to success and deal with them.

n Show measurable improvement - measure your meeting 
times and satisfaction (before and after the process is 
implemented). See ‘Section VI: Resources’ for a 
participant survey.

n Make periodic checks - make sure everyone is 
participating and accepts the process (perhaps during 
the face-to-face portion of the meeting).

n Develop and follow procedures - does your team require 
additional guidelines?

n Determine if GroupSystems will be effective elsewhere!

5HPHPEHU�7KLV���
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�,,

6HWWLQJ�XS�WKH�7HFKQRORJ\

6WHSV

q Log in to GroupSystems

q Create the Staff Meetings Folder in GroupSystems

q Create the List of Members

q Create the Staff Meeting Master

q Copy the Staff Meeting Master

q Test GroupSystems

6WDII�0HHWLQJV
IRU�:RUNJURXSV
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Log in to GroupSystems as a full-access user. This procedure will vary 
greatly from organization to organization. Get help from your 
GroupSystems administrator if you need it.

1. Use the Start button in Windows 95 to find and load 
GroupSystems (or double-click on the GroupSystems icon 
if it is on your desktop). 

2. The GroupSystems log-in dialog appears.

3. Enter your login name (as provided by your system 
administrator) and optional password.

4. Choose OK.

(continued...)

'R�7KLV���
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(...continued)

5. When you have logged in, you should see a screen that 
looks something like this:

6. GroupSystems will automatically open the most recently 
used folder. 

'R�7KLV���

Your screen may vary because you or someone else may 
have hidden some or all of the application bar’s buttons. 
Also, the last activity you were accessing will be open 
when you log in.

5HPHPEHU�7KLV���
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&UHDWH�WKH�6WDII�0HHWLQJV�)ROGHU

&UHDWH�D�QHZ�IROGHU�

1. Click the Add Folder button on the toolbar.  
OR from the Folders menu, choose Add Folder.

2. Type the name for your staff meeting in the Folder 
Name text box.

3. Select the folder under which you want to place the new 
folder. By clicking on {Root}, the new folder will appear 
as a main folder (rather than a subfolder).

4. Click OK. The folder is now ready for you to use.

'R�7KLV���
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&UHDWH�WKH�/LVW�RI�0HPEHUV

(The members cannot access or be invited into any activities in 
the meeting until you include them on the folder roster. When 
new employees join your team, make sure to add them here.)

&UHDWH�WKH�OLVW�RI�PHPEHUV��

1. Click on the People button. 
OR click the Windows option on the main menu bar and 
select People. 

2. A People dialog like this should appear:

3. Click on the Roster button.  
The Edit Folder Roster dialog will appear. 

(continued…)

'R�7KLV���
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(...continued)

4. Select the available names from the left side and click 
the Add button to add them to the folder roster on the 
right side of the dialog window. 

5. Click OK when you are done.

6. The People window should now show the names of the 
members you will include in the session. 

7. Click the Close button  to close the People window.

'R�7KLV���
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&UHDWH�WKH�6WDII�0HHWLQJ�$FWLYLW\�0DVWHU

In the folder that you just created, you will now need to create a 
“master” of the Staff Meeting activity. You will then be able to save time 
by copying the information from the master for each new staff meeting.

&UHDWH�WKH�6WDII�0HHWLQJ�0DVWHU

1. From the folder that you created earlier, click on the 

Agenda Button. 
OR, click the Windows option on the main menu bar 
and select Agenda. 

2. Click the Add Activity button on the toolbar. 
OR, from the Agenda menu, choose Add Activity.

3. Choose Group Outliner as the activity type. 

4. Type “Staff Meeting Master” into the Name field (and if 
desired, enter a more detailed description in the 
Description field).

5. Click OK. The new Staff Meeting Master activity will 
now appear on the Agenda.

'R�7KLV���
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&RQILJXUH�*URXS�6HWWLQJV

Be sure to configure the Staff Meeting Master activity with 
the following Group Settings for your team.

1. Open the activity by double-clicking on it. You will see a 
blank Group Outliner screen that looks like this:

2. Click the Group Settings button. 

(continued...)
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(...continued)

3. Configure the Group Settings as in the picture below:

4. Click OK.

5. Close the Group Outliner activity. 

'R�7KLV���
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$GG�WR�DQG�PRGLI\�WKH�RXWOLQH

1. There are several formats that work well with the asyn-
chronous portion of the staff meeting. You may create 
headings for each staff member’s name, or add headings 
related to functions that your department performs. 
Choose the one that would be best for your team. (If you 
choose to group entries by topic rather than person, see 
Section V for information on how to turn on Author Tags.)

2. To add a staff member name or topic, click once where 
you want to insert the topic, then click the Add Topic 

button.  
Select the Append, Before or After radio button at the 
left of the Add Topic window, enter the text for the topic 
name, and click Submit. 

3. To change a staff member name or topic, close the Add 
Topic window, click once on the topic and press <F5>. 
Modify the text as necessary, and click Submit.

(continued...)

'R�7KLV���
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(...continued)

4. To move a staff member name or topic, click and drag 
the topic on top of another, and select Move Before or 
Move After from the menu that appears. 

5. To remove a staff member name or topic, click once on it 
and press the Delete key on your keyboard.

'R�7KLV���
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5HTXHVWLQJ�$GGLWLRQDO�,QIRUPDWLRQ�IURP�WKH�7HDP

1. You can also use TLA’s (three letter acronyms) to request 
specific information from the team. Two recommended 
TLA’s are:

n RFD (Request For Decision by the group as a whole)

n RFI (Request For Information from group in general)

Several days prior to each new meeting you will need to 
copy the Staff Meeting Master to a new Agenda activity, 
modify its name, and start the team members using the 
instructions in Section III.

5HPHPEHU�7KLV���

5HPHPEHU�7KLV���
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&RS\�WKH�6WDII�0HHWLQJ�0DVWHU

1. Click once to select the Staff Meeting Master activity on 
the agenda.

2. Press <Ctrl-C> or from the Edit menu on the menu bar, 
select Copy.

3. Move the mouse to the bottom of the Agenda and 
highlight the last activity on the list. Press <Ctrl-V> or 
from the Edit menu on the menu bar, select Paste. 
This will insert the copied activity at the bottom of the 
agenda.

4. To move the agenda activity, click on it 
once and drag it on top of another 
activity on the agenda. Let go of the 
mouse button and choose Move Before 
or Move After from the menu that appears. 

5. Press <F5> and edit the activity name to reflect the cur-
rent date. 

6. Click OK.

'R�7KLV���

People don’t like to see their names consistently “at the 
bottom of the list” (unless you are using alphabetical 
order). Consider moving their names around in the 
outliner from meeting to meeting, perhaps moving the 
person at the bottom to the top of the list the next week.

Refer to the section “Add to and Modify the Outline” for 
help moving information in the outline.

5HPHPEHU�7KLV���
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7HVW�*URXS6\VWHPV

Test that GroupSystems is running correctly. 

1. Ask another team member to log in to GroupSystems on 
another computer.

2. From the team leader’s station, click on the Agenda 

Button. 
OR, click the Windows option on the main menu bar 
and select Agenda. The Agenda window like this 
should appear in the leader’s workspace: 

3. Select the Staff Meeting activity on the agenda and 
double-click it. This opens the group outline on the 
leader’s station. 

4. Click the Start Participants button. 
The Start Participants dialog will appear.

5. Click the Select All button (or click the name of the par-
ticipant who logged in in Step 1), then click OK.

(continued...)
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(...continued)

6. Check to see that the Group Outliner appears on the 
participant’s screen. Contact your GroupSystems admin-
istrator if you have problems.

7. Click on the Stop Participants button. 
A Stop Participants dialog will appear.

8. Click Select All to select all participants, then click OK. 

'R�7KLV���
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�,,,

0HHWLQJ�³9LUWXDOO\´

6WHSV

q Start the Team Members in GroupSystems

q Invite Team Members via E-mail

q Access the Staff Meeting from an E-mail Message

q Access the Staff Meeting Manually

q Review and Update Status Information

q Request Information and/or Decisions of the Group

q View and Print Electronic and Paper Reports

6WDII�0HHWLQJV
IRU�:RUNJURXSV
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6WDUW�WKH�7HDP�0HPEHUV�LQ�*URXS6\VWHPV

After you have created the Agenda activity you need to start the team 
members. Even if team members miss your “invitation” they will still 
be able to access the activity as long as you have started it for them.

1. Open the Agenda by clicking on the Agenda button. 

2. Double-click to open this week’s Staff Meeting activity on 
your own screen.

3. Click on the Start Participants button. 

4. Click on the Select All button to select all participants, 
then click OK.

'R�7KLV���
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,QYLWH�7HDP�0HPEHUV�YLD�(�PDLO

The first few times you conduct an electronic meeting, you will proba-
bly want to remind the staff to log in to GroupSystems and report their 
status information. Thereafter the group may not require reminders to 
update their information. 

If necessary, use the invitation to remind members about the time frame 
which they should follow when contributing to the Staff Meeting.

You can use e-mail to invite staff members to join the staff meeting.

6HQG�D�*URXS6\VWHPV�,QYLWDWLRQ�YLD�(�PDLO

1. From the Agenda list, select the activity for which you 
want to view information. 

2. From the Agenda menu, choose View Activity 
Information, or select the Info button. 
The Activity Information dialog box appears.

3. Click the Copy Link button, then click the Close button 
to exit the current dialog box.

4. Minimize GroupSystems and any other programs 
running so that your desktop is visible.

5. Right click on a blank area of the desktop, and from the 
menu choose New—Shortcut.

6. Paste the copied link into the command line and click 
Next.

(continued...)
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(...continued)

7. Give the shortcut a logical name, and click Finish.

8. Open your e-mail program, create a new e-mail message 
and address it to the people you would like to receive 
the link.

9. Position the window of the e-mail message so that it 
covers only part of the desktop. Drag the shortcut you 
just created from the desktop onto the body of the email 
message.

10.Compose an invitation to the members (as in the exam-
ple on page 35). Remind the members:

n Of specific deadlines for contribution;

n That a face-to-face meeting will attempt to resolve 
anything that has not been resolved online; and

n They may need to log in more than once to “wrap 
things up”.

11.Send the message.

'R�7KLV���
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$OWHUQDWH�0HWKRG

You may also send members a path statement they can use 
to launch the GroupSystems folder. 

1. Complete steps 1-3 and 8 above.

2. In the message area of the e-mail, press <Ctrl-V> to 
paste the copied link as a DOS path statement. Type any 
additional information or instructions, as necessary.

'R�7KLV���
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3$57,&,3$17�,16758&7,216

$FFHVV�WKH�6WDII�0HHWLQJ�IURP�DQ�(�PDLO�0HVVDJH

The team members will receive an e-mail message from the team leader 
and use the link to launch the GroupSystems activity.

7R�ODXQFK�WKH�*URXS6\VWHPV�DFWLYLW\�

1. If you receive an e-mail message with a GroupSystems 
link in it, double-click the link to launch the program.

2. If you receive a path statement instead, highlight the 
link’s path in the message and press 
<Ctrl-C> to copy to the clipboard. 

3. Go to the Windows Start menu and select Run. 

4. Press <Ctrl-V> to insert the link into the command line. 

5. Click OK.
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$FFHVV�WKH�6WDII�0HHWLQJ�0DQXDOO\

Refer to the Login instructions at the beginning of Section III: Set Up the 
Technology.

When you log into GroupSystems the name of the current folder appears 
in the program title bar. If you are not in the folder where the staff meet-
ing resides, switch to that folder using the Folder List.

1. Click the Folders button on the toolbar. 
OR, from the Folder menu on the main menu bar, select 
Folder List.

2. Find the designated staff meeting folder and double-
click it to open it.

3. From the Folder menu on the main menu bar, deselect 
Folder List. 
OR, click the Folders button on the toolbar to close the 
Folder List. 

4. Looking at the Agenda, double-click the activity for the 
current week (whichever week you want to open).

'R�7KLV���
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5HYLHZ�DQG�8SGDWH�6WDWXV�,QIRUPDWLRQ

Communicate general status update information for your team 
asynchronously. When you do meet as a team, the face-to-face 
meeting will take much less time because everyone will already have 
the information they need.

$GGLQJ�6WDWXV�,QIRUPDWLRQ

1. With the mouse, select your name or the appropriate 
heading on the outline.

2. Click the Add Topic button. 

3. Select Sub on the left side of the Add Topic dialog window. 

4. Type your information and click Submit. 

(continued...)

'R�7KLV���
3DJH��� �������9HQWDQD�&RUSRUDWLRQ 6WDII�0HHWLQJV�IRU�:RUNJURXSV



Note: When a new topic is submitted by another staff member, the 
other members may see a red exclamation point (!) next to that topic. 
These will go away each time you exit the activity or as you select and 
read each topic on the outline. 

To clear all the red exclamation points from the topics, choose Clear 
New Markers from the Edit menu.

(GLWLQJ�6WDWXV�,QIRUPDWLRQ

(...continued)

5. Repeat as necessary.

6. Click Close to exit the Add Topic dialog window.

'R�7KLV���

1. With the mouse, select the branch on the outline you 
want to edit.

2. Press F5. The Edit Topic dialog appears.

3. Revise the text, then click Submit.

Note: In addition to the drop-
down menus and application 
buttons, you can right-click your 
mouse button on the selected 
topic to access the following 
menu: 

'R�7KLV���
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0RYLQJ�DQG�0HUJLQJ�6WDWXV�,QIRUPDWLRQ�

After adding status information within your area of the outline, you 
may find it necessary to move a topic to a different position in the out-
line (or to merge two topics).

$GGLQJ�DQG�9LHZLQJ�&RPPHQWV

Use comments to pose a question or to provide guidance and/or 
suggestions to a specific person. You can add comments to any area of 
the outline.

There are two comment counters to the left of each topic name. The first 
number refers to the total number of comments, and the second num-
ber refers to the comments not seen by the staff member. 

For example, “8/2” indicates that eight comments are attached to the 
topic, but two of them comments have not been viewed. Once the staff 
member views the comments (through the Comment window) the 
counter will display “8/0”.

1. Select the topic from the list (it will become highlighted).

2. Drag the topic text to a new area of the outline. The 
mouse pointer changes to a white page with the corner 
turned down. A topic will display a box outline as the 
mouse pointer is moved over the topic text.

3. Release the mouse button when the desired area 
displays the box outline. 

4. Select either Move Before, Move After, or Move Sub 
from the popup menu. 

'R�7KLV���
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When a new comment is submitted by another staff member, the other 
members may see a red exclamation point (!) next to that comment in 
the Comment window. These will go away each time you exit the Com-
ment window or as you select and read each comment. 

To clear all the red exclamation points from the comments in a particu-
lar window, from the Edit menu, choose Clear New Markers.

1. Close any dialog windows that are open.

2. Select the desired outline topic. Double-click the topic, 
or click the View Comments button. 

3. A comment window appears that displays the selected 
topic in the title bar. Any existing comments will be 
listed in the public text area. The insertion point is 
binking at the bottom of this window in the comment 
editing pane.

4. Type in your comment and click Submit.

'R�7KLV���
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5HIHU�WR�FRPPHQWV�PDGH�E\�RWKHUV�XVLQJ�WKH�
IROORZLQJ�IRUPDW�

1. Select the comment you wish to reply to with the mouse. 
Note the comment number that appears after the com-
ment. 

2. Click once in the text window.

3. Type your comment, prefaced with “Ref #x...” to refer 
directly to that comment.
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5HTXHVW�,QIRUPDWLRQ�DQG�RU�'HFLVLRQV�IURP�WKH�*URXS

8VLQJ�WKH�5)'��5HTXHVW�)RU�'HFLVLRQ�

When you wish to request a decision from the group as a whole, add this 
as a subtopic to the RFD area of the outline. Give the RFD a short 
“headline” as the subtopic, and enter more specifics as comments. The 
staff will discuss each RFD using Add/View Comments. 

Decisions can be made face-to-face or via GroupSystems resources such 
as Opinion Meter. Remember, you can request a decision from a particu-
lar member by adding your question as a comment to their name on the 
outline.

8VLQJ�WKH�5),��5HTXHVW�)RU�,QIRUPDWLRQ�

When you wish to request a information from the group as a whole, add 
this as a subtopic to the RFI area of the outline. Give the RFI a short 
“headline” as the subtopic, and enter more specifics as comments. The 
staff will discuss each RFI using Add/View Comments. 

See the following example:

Remember, you can request information from a particular member by 
adding your question as a comment to their name on the outline.
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9LHZ�DQG�3ULQW�(OHFWURQLF�DQG�3DSHU�5HSRUWV

You can share your Staff Meeting information with others. You can print 
this information, or the leader can create an electronic report to be 
included as an e-mail attachment, for example. Reports and printouts 
can be created and viewed during or after any GroupSystems activity 
(see Section IV).

7R�9LHZ�DQ�(OHFWURQLF�5HSRUW

7R�3ULQW�D�5HSRUW�)URP�:LWKLQ�WKH�$FWLYLW\

The leader can quickly print out the data from a single activity through 
the Print command on the File menu.

1. Click the Reports button on the main toolbar.  
OR, from the Window menu, choose Reports. 
The Reports window will appear.

2. Select the report you wish to view and click the View 
Selected Report button.  
OR, double-click on the report icon. The text of the 
report will appear in a separate application window. 

3. Use File—Save As to save a copy of the text to be 
emailed as an attachment. To send just the text, use 
Edit—Copy followed by Edit—Paste.

'R�7KLV���

1. Make sure the window for the desired activity is open.

2. From the File menu, choose Print. The Print dialog box 
appears. 

3. Choose your desired report options and click OK.
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�,9

)ROORZ�XS�$FWLYLWLHV

6WHSV

q Create Electronic Reports

q Temporary Leader Privileges

6WDII�0HHWLQJV
IRU�:RUNJURXSV
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&UHDWH�(OHFWURQLF�5HSRUWV

The leader can quickly create an electronic report of individual 
activities or of the entire list.

1. From the Window menu, choose Reports. 
OR, click the Reports button on the main 
toolbar.  The Reports window will appear.

2. From the Reports menu, choose Add Report. 

OR, click the Add Reports button on the toolbar. 

3. Enter a name for the report.

4. Select the activity from the Available Items list box.

5. Choose Add. The item will appear below in the Report 
Items list box. Options appear in the Include section of 
the dialog box. The cursor will drop down to the next 
item on the Available Items list box. 

(continued...)
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(...continued)

6. Repeat steps 4-5 to add more items to the report. 
Note: To remove an item from the Report Items list box, 
select an item from Report Items and click the Remove 
button. 

7. Click OK to create the report. 

8. After a moment, the report will appear in the Reports 
window. A Windows Write, Notepad, MS-Word or 
WordPerfect icon will diplay next to the report name 
indicating its file format.
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7HPSRUDU\�/HDGHU�3ULYLOHJHV

If the team leader is out of the office or unable to create the new staff 
meeting for the week, that person can temporarily give these privileges 
to another team member. 

1. Open the Staff Meeting folder. 

2. From the Agenda, click the Group Settings button. 

3. In the Apply To: window, choose the person you want 
to give the privileges to. 

4. Select Add Activity. This will give the person the ability 
to add a new agenda activity, which will automatically 
give them full rights within that activity.

5. Click OK. 

6. When you no longer wish for that team member to have 
these privileges, repeat the above and reverse Step 4. 
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�9

6XSSOHPHQWDO�,QIRUPDWLRQ

6WHSV

q Choose the Participants

q Set Expectations

q Set Up Author Tags

6WDII�0HHWLQJV
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&KRRVH�WKH�3DUWLFLSDQWV

The success of a successful Staff Meeting depends in part upon having 
the right people involved. The list must include your staff. Your staff 
should understand the reason why this new process is being used, what 
their role(s) are, how their contribution/participation will be evaluated, 
and how they will receive performance feedback. Be clear about dead-
lines and deliverables.

Consider very carefully the implications of including people in this 
process who do not report to you, do not take direction from you, or are 
not evaluated by you.

Your goal is to provide your staff with a tool that reduces interference 
and allows them to focus on a clear goal, while holding them account-
able for their work. Staff Meeting, coupled with your direction, will help 
produce a high performance team.

Successful participants of the Staff Meeting share the following trainable 
characteristics:

n Strong communication skills, both verbal and written.

n Ability to initiate dialog. They don’t wait to be asked.

n Strong work ethic. They understand what needs to be done, and are 
able to stay on task through completion. 

n Able to cope with technology. The occasional printer or computer 
problem, etc. should not cause frustration on the part of team 
members.

Don’t abandon face-to-face meetings completely. They are 
still important for:

n Team-building

n Networking

n Conflict resolution

5HPHPEHU�7KLV���
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6HW�([SHFWDWLRQV

Team members can agree in advance to guidelines for contributing to 
the Staff Meeting.

0HPEHUV�VKRXOG�

1. Follow norms and guidelines.

n Formal or informal

n Frequency of participation

n Confidentiality

n Response time expected 

2. Use strong writing skills.

3. Cope with the technology. Network communication comes with its 
own challenges which staff members will learn to meet.

4. Make up for lack of body language. Let people know how you are 
feeling.

n Use “emoticons” to clarify when you are using humor or are 
confused.

n Be careful with irony and sarcasm. They often come across as 
open hostility online.

n Communicate with others as you would have them 
communicate with you. 

n Write with others in mind. Reading all that text on the screen can 
get boring. Use short statements, and enter full descriptions as 
comments to the short statements.
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6HW�8S�$XWKRU�7DJV

If you have your Staff Meeting set up by topic heading rather than by 
staff member name, it may be helpful to configure GroupSystems to 
automatically add a person’s name or subgroup identification after 
their comment. This will help the team to identify who placed a com-
ment and to whom requests for clarification should be addressed.

1. Double-click to open the Staff Meeting for which you 
would like to assign subgroup identification (author 
tags).

2. From the Agenda, click the Group Settings button. 

3. On the lower portion of the Group Settings dialog, 
select Author Tag.

4. Click OK.
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6WDII�0HHWLQJV�IRU�:RUNJURXSV

6HFWLRQ�9,

5HVRXUFHV

6WHSV

q Additional GroupSystems Tools and Resources

q Bibliography

q Author Biography and Acknowledgments

q Electronic Meeting Feedback Questionnaire

6WDII�0HHWLQJV
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As you become more familiar with GroupSystems, you will want to uti-
lize it for more than just staff meetings. See the chart below for an over-
view of the tools that are included in GroupSystems Professional Suite. 

For help with these tools and resources, use the GroupSystems Help 
command, contact your GroupSystems administrator, or contact Ventana 
Corporation at (800) 368-6338.

Tool Name Characteristics Sample Activities Comparisons

Topic 
Commenter

Encourages a group 
to provide depth 
and detail on a 
small set of topics.

• Explore task areas for a new 
plan.

• Discuss strengths and 
weaknesses of a policy.

• Conduct focus group 
research.

• More focused than 
Electronic 
Brainstorming.

• Less structured than 
Categorizer.

Categorizer Used for 
categorizing ideas 
and generating 
single or multiple 
lists.

• Organize information on a 
competitor.

• List new technologies 
suitable for further 
investigation.

• Perform a cause and effect 
analysis.

• Organize data from another 
tool.

• More structured than 
Electronic 
Brainstorming.

• More powerful than 
Topic Commenter.

Vote Provides a quick 
snapshot of group 
consensus. Used to 
evaluate, make 
decisions, and/or 
build consensus.

• Rank new product 
characteristics.

• Prioritize objectives.
• Indicate the extent of 

agreement with a company 
policy.

• Select the top three lending 
agencies.

• More detailed and 
analytical than the 
Opinion Meter 
resource.

• Allows cumulative 
voting (several votes 
per login).

Group 
Outliner

Used to generate 
and/or organize 
ideas into familiar 
hierarchical 
structure.

• Draft a company business 
plan.

• Outline a grant proposal.
• Organize a marketing 

campaign.

• More highly structured 
than Electronic 
Brainstorming or 
Categorizer.
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Note: Topic Commenter and Survey offer increased flexibility through 
the use of the GroupSystems Palm Add-in for the Palm Organizer 
(“GroupSystems Unplugged”).

Electronic 
Brainstorming

Encourages a team 
to diverge from 
customary thinking 
patterns in search of 
new ideas.

• Explore how to gain market 
share.

• Discuss our most important 
product or service.

• Share what is feasible for 
your department to 
accomplish this year.

• More breadth than 
Topic Commenter or 
Categorizer.

• Provides keywords / 
synonyms for 
grouping items.

Alternative 
Analysis

Used to evaluate 
alternatives based 
on multiple criteria.

• Evaluate job candidates on 
different skills.

• Rate vendors on a number of 
different requirements.

• Allows for multi-
criteria evaluation.

• Provides more tabular 
and graphical results 
than Vote.

Survey Used to build, 
distribute, and 
collect survey 
forms.

• Conduct focus group 
research.

• Gather feedback on 
employee benefits.

• Assess customer needs.

• Allows you to combine 
evaluative methods 
(e.g., 10-Point Scale, 
Yes/No, Open-ended).

• Includes a stand-alone 
version for collecting 
data outside of 
GroupSystems.

• Distribute 
GroupSystems survey 
through a web site.

Activity 
Modeler

• Used to describe 
a business 
process verbally 
and graphically 
in a collaborative 
IDEF0 diagram

• Includes activity 
based costing

• People from different areas in 
an organization can create 
accurate business models

• More graphical than 
Group Outliner—
graphical engine 
draws process in terms 
of activities and the 
connections (ICOMs).

Tool Name Characteristics Sample Activities Comparisons
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1. Participant Background

What did you hope to produce in today’s meeting?

2. Interest Accommodation 1 3 5

Today, my interests were... not 
accommodated

accommodated

Thinking about what I needed from this 
meeting...

I did not get it I got it

The outcome of today’s activities... does not meet my 
personal needs

meets my
personal needs

3. Process Satisfaction 1 3 5

The meeting methods we used today... did not meet my 
expectations

met my
expectations

Today’s meeting process was... inadequate to 
meet our goals

adequate to meet
our goals

The group used its time well, devoting 
enough attention to the important issues.

disagree agree

4. Product Satisfaction 1 3 5

The product of this meeting... did not meet my 
expectations

met my
expectations

The outcome of today’s meeting is... unsatisfactory satisfactory

The results of today’s meeting are... inadequate adequate



7. Do you have any other remarks? 

8. Please describe what you think will be the impact of this meeting. 

5. Cultural Meeting Background 1 3 5

I felt more comfortable in this electronic 
meeting than in most other meetings.

disagree agree

The tools and methods we used today 
would adequately support my usual 
meetings.

disagree agree

Thinking about the tools and methods we 
used today...

I prefer other 
tools and 
methods

I prefer today’s
tools and
methods

6. Other 1 3 5

Did the facilitator/moderator have 
sufficient knowledge of the issue at hand 
to moderate the process well?

insufficient sufficient

The influence of the facilitator/moderator 
on the meeting process was...

negative positive


	Contents
	TEAM LEADER INSTRUCTIONS
	Welcome!
	Software and Hardware Requirements
	Minimum Requirements
	Recommended Configuration

	Understand Staff Meetings for Workgroups
	Process

	What is GroupSystems?
	How People Connect Using GroupSystems


	Getting Started
	Before You Begin
	Plan the Staff Meeting Format
	Launch the Staff Meeting

	Setting up the Technology
	Log in to GroupSystems
	Create the Staff Meetings Folder
	Create the List of Members
	Create the Staff Meeting Activity Master
	Create the Staff Meeting Master
	Copy the Staff Meeting Master

	Test GroupSystems

	Meeting “Virtually”
	Start the Team Members in GroupSystems
	Invite Team Members via E-mail
	Send a GroupSystems Invitation via E-mail


	PARTICIPANT INSTRUCTIONS
	Access the Staff Meeting from an E-mail Message
	Access the Staff Meeting Manually
	Review and Update Status Information
	Adding Status Information
	Editing Status Information
	Moving and Merging Status Information
	Adding and Viewing Comments

	Request Information and/or Decisions from the Group
	Using the RFD (Request For Decision)
	Using the RFI (Request For Information)

	View and Print Electronic and Paper Reports
	To View an Electronic Report
	To Print a Report From Within the Activity


	Follow-up Activities
	Create Electronic Reports
	Temporary Leader Privileges

	Supplemental Information
	Choose the Participants
	Set Expectations
	Set Up Author Tags

	Resources
	Additional GroupSystems Tools and Resources
	Staff Meetings for Workgroups Bibliography
	Author Biography
	Acknowledgments
	Electronic Meeting Feedback Questionnaire


